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Introduction

Welcome to the MOT Form 700-50-67/68. The purpose of this document is provide guidance on how to
properly use the Excel form.

This form is not required and it will not work for Lump Sum or Design Build contracts. Additionally, Push
Button contract quantities must be entered manually. The error below will be generated if a Lump Sum,
Design Build, or Push Button contract number is entered. For Push Button contracts or contractors
wanting to utilize this form for their own quantity tracking, a blank form can be generated for another
contract number and the project information can be removed.

Opening Form

NOTE: This form can be retrieved using two different paths:
e The first option is the Forms and Procedures website which provides a direct link to the
Final Estimates Forms website (see below).

e The second option is directly from the Final Estimates Forms website (see below). Click

on the form number to open the Excel file.

700-050-67/68 MOT - Painted Pavement Markings Daily Worksheet & Certification of Quantities (Instructions)*

Opening form (from the Construction Office website)

Before the form file will open, a window will appear prompting the user to: Open, Save, or Save As (see
window below).
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If Open is selected, the form will open from the website as an Excel file.

If Save is selected, the form will save to a default location determined by the user’'s computer and
typically unknown to the user. Itis not recommended that this be selected. If it is option chosen, please
note where the computer saves it.

If Save As is selected, the form will be saved to a location specially chosen by the user. This is the
preferred choice and will be beneficial when the file is exported (as discussed later in the instructions).

Once the Excel file is opened, a prompt to enable editing and/or enable content may appear. In order to
use this form editing and enable content must be enabled. If asked to trust a process, choose "Yes".

The security warning will look like this:

| SECURITY WARNING Macros have been disabled. Enable Content
The form will check for an internet connection. If no If connected to the internet, the form will prompt to
connection is found, a notice to that effect will provide a valid Contract ID, then the form will obtain
appear on the screen. contract and pay item data from the FDOT servers.

You are not currently connected to the internet. Will be
using existing contract information. Once you are able to
connect to the internet reopen this warkbook. Enter Contract ID

—
o

Main Menu

The Main worksheet tab at the bottom of the form allows for adding new daily worksheets, updating the summary
pages and exporting the worksheets prior to submitting to FDOT.

Add New Daily Worksheet

Daily worksheets can be added as needed. However, it is recommended to only add one for each day.

Daily Worksheets

Daily worksheets are used to record each day’s quantities, location, and any special remarks concerning each
pay item.

IMPORTANT! DO NOT rename these worksheet tabs.
Doing so will break the code and the form will no longer work.

NOTE: Any changes to these daily worksheets will not show up on the summary page until they have been
updated from the main menu.
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Add New Daily Worksheet

1. Add a new daily by selecting the “Add New Daily Worksheet” button.

2. Alist of pay items by Project ID will appear.
a. First select the Project ID from the pull down
tab.
b. Select all the items to be reported on this
Daily worksheet. You may use the "Select
All" button if you need all items.
Tip: You may select all items every time
and just record 0 for the unused quantities.
c. Select “Create New Daily”.

NOTE: DO NOT add additional pay items. The form is
designed to pull the contract pay items from
SiteManager. If the form is missing a pay item on your
contract, contact the System Section.

Add Quantities to Daily Worksheet

1. Select the appropriate daily worksheet tab at the bottom of the form.
a. NOTE: Each daily will be named as follows:
i. Project ID Number underscore Daily Sequence Number
Example: 2100035201_Daily1
IMPORTANT! DO NOT rename these worksheets.

Doing so will break the code and the form will no longer work.

2. Enter the Date: Cell P5.

3. Enter the Certification Number: Cell C5

4. Enter the name of the person certifying the quantities: Cell N7

5. Enter quantities in Column J starting on Row 12 for each reported item

6. Enter Location in Column L starting on Row 12 for each reported item
a. Location is Required

7. Enter Remarks in Column N starting on Row 12 for each reported item

a. Remarks are not required.

Remove Quantities from Daily Worksheet
There are two options for removing quantities from the daily worksheet.

Option One
1. Select the row of the item to be removed and delete that row.

Option Two
1. Setthe quantity for the item to zero.
a. This item will be filtered out on the summary page.
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Remove or Delete Daily Worksheet

A daily worksheet may be deleted at any time. Doing so will not update the summary
worksheet. The summary pages must be updated manually on the main tab if any of the daily
worksheets are deleted or modified.

Right click on the daily worksheet tab to be removed or deleted, then select Delete.

Update Summary Worksheets

To update the summary worksheet, the quantities from the dailies for each project are collected and summed.
This process must be done each time you make a change to one of the dailies.

1. Onthe ‘Main’ tab, select the “Update Summary Worksheets” button.
Once the process is complete. A status message will be displayed:

Done Updating Summaries
Export Sheets and Close

Selecting the "Export Sheets and Close” button on the ‘Main’ tab will export all summary and daily worksheets to
another worksheet. This step is important in order to remove the program code and to make the file smaller for
submittal to FDOT.

NOTE: It is important to save the spreadsheet prior to exporting. The NewCopy ===
exported worksheet will be saved in the same location as the original
Excel spreadsheet (as discussed on Page 2); therefore it is crucial to e oy O o B e coment workbaok

note where the spreadsheet is saved prior to exporting. The opportunity
to change the location of the saved file will not be allowed during the
export process.

Signature blocks must be added to the form prior to exporting (see Digital Signature section below). However,
the signature blocks do not need to be digitally signed until after the worksheet has been exported. The form will
not export if it is digitally signed.

On the Main tab, select the “Export Sheets and Close” button

A window will appear asking for confirmation of the exporting action.

Select “Yes” to proceed or “No” to cancel. ("New Copy 5=)
Provide the name of the new workbook and select "OK". lense Soecifo th . ook
The currently opened workbook will close and the new SRS
workbook will be saved in the same folder where the =
original one is located.

agrpONE

This Workbook shall be signed and submitted to the Department
or uploaded to the collaboration site (i.e., Project Solve) as an Excel file.

NOTE: Ensure the file extension is .xIsx and not .xls or .xIsm. The Save as type: drop down option should be
“Excel Workbook”, not “Excel 97-2003 Workbook.”

IMPORTANT! Follow all current procedures related to EDMS.
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Digital Signature

The use of digital signatures is supported by selecting the check box in the upper right corner of the Main Menu.
To insert digital signature blocks on the Summary page, select the Digital Signature check box and "Update
Summary Worksheets". (Unchecking this check box will remove the digital signatures blocks and insert the

standard signature block.)

NOTE: Digital signatures are required for use on projects let July 2016 and after. The digitally signed Excel file

shall be submitted to FDOT. Do not print a digitally signed file and submit as a PDF.

Digital Signing with Excel

To produce a valid digital signature, prior to applying your digital signature in Excel, ensure the calculation

options are set to Manual.

fx E I I I I IE‘V\ . | Calculate Now
Insert  AutoSum Recently Financial Logical Text Date & Lookup atch Cakl_:lahnn B Calculate Sheet
Function = Used ~ = = - Time~ Referen ndow
Function Library Automatic
Al - £ Automatic Except for Data Tables
l v Manual I
A B C 0O E T A

Then click Calculate Now on the Formulas tab.

Page Layout Data

File Home Insert

fx I I I I E 5 Calculate Now
Insert AutoSum Recently Financial Log|ca| Text Date & Looku Calculation !:‘El Calculate Sheet
Function © Used - < -  Time~ Referenc <‘[Jp-t|or1sv
Function Library Calculation
Excel 2013

1. Open the file to be digitally signed.
2. On the last sheet, right-click on the “Digital Signature” box and select "Sign"
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3. Enter your name in the text box and select “Sign”. Accept the Signature Confirmation prompt by

selecting "OK".

Excel 2016

@ Ssee additional information about what you are signing..

Before signing this document, verify that the content you are signing is correct. ‘

Type your name below, or dlick Select Image to select a picture to use as your
signature:

Signature_gonlirmalion L = J
X Join ooe s, || || () S e e e
Contratot hhorized Agent 7] Don't show this message again I
|
To include information about the signer, dick the details button. [MT] ‘
1. Open the file to be digitally signed.
2. Onthe last sheet, click View Signatures in the yellow ribbon.
| SE—

0 SIGNATURES

This document contains valid signatures.

View Signatures...

3. Select the down arrow next to the field to sign, then select Sign.

4. Enter your name in the text box and select “Sign”. Accept the Signature Confirmation prompt by

selecting "OK".

Saving a Signed File from Email

To obtain multiple signatures on the form, it is likely the form will be emailed from user to user. Right- click on the
attachment and select "Save As" or "Save All Attachments". See tips below.
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Message @TEST.]HSH

Preview
Qpen NOTE: Do not double click to open and save the file. The
Quick Print digital signatures will be removed.

Thank you! Save As

Uy Save All Attachments...

Ashley Awnderspn
Final Estimate Specialist

State Construction Final | B2 Copy
Flgrida Department of Tr

X & 8] &

Remove Attachment

Additional Information

Additional guidance on digital signatures, how to obtain them from providers and how to properly use them can
be accessed on FDOT's Construction website at:
http://www.fdot.gov/construction/eConstruction/Digital Signatures.shtm

Reset

The "Reset” button on the ‘Main’ tab will reset the p .
workbook to the default contract state. It will delete all WEngT ==
worksheets and recreate the summary sheets for each contract.

Reset form? this will reset back to Default setting.
1. Select the “Reset” button

a. A window will appear asking for confirmation of

the action. R Wz

b. Select“Yes” to proceed or “NO” to cancel. L
c. Provide the Contract ID.

i. Once you provide the Contract ID, select “OK” to reset the form.

Tips
Saving File

Just close the spreadsheet. Do not try to File > Save As after a digital certificate is applied.
To save from an email, see instructions below.

Renaming File
If you need to rename the spreadsheet after a digital signature is applied:

a. Close the file and right click > Rename

PN N e

Copy

Create shortcut
Delete

Rename

Properties
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b. Or, double-click on the file name so it become editable.

Emailing File
To email the spreadsheet, drag the file from your folder into the email.

To save the spreadsheet from an email, drag the file from the email to your folder.
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Invalid Digital Signature

A recent update to Excel forces the menu bar settings to be global (all files) instead of for each individual file, so

the manual calculations settings does not lock as it once did.

To test if this is the problem:
1. Open a blank Excel workbook.

2. Then, select Formulas > Calculation Options > Manual
Page Layout Data Review View Developer Help BLUEBEAM

I Iﬂ |El =y &I Define Name - o Trace Precedents %] Show Formulas
=

ﬂCETra(e Dependents ¥4 Eror Checking ~

Date & Lookup & Math&  More Name

- Time~ Reference~ Trig~ Functions= Manager I'E' Create from Selection R\ Remove Arrows = 'Z:)E:} Evaluate Formula  window Options *

rary Defined Names

P Tell mewhat you want to do

Automatic Except for Data Tables

3. Leave this file open in the background and open the digitally signed file in question. The settings from
the blank workbook should carry over to the digitally signed file and the digital signature should show
valid if the Excel Update is the issue. If you have additional questions, contact the SCO System Section
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